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        Users trust to manage documents on pdfFiller platform

        
                                                
                        65.5K+

                        documents added daily

                    

                                    
                        53%

                        of documents created 
from templates
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                        PDFs edited per month
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                        documents shared 
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                All-in-one PDF software
            

            
                A single pill for all your PDF headaches. Edit, fill out, eSign, and share – on any device.
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            Rearrange Number Transcript: full-featured PDF editor

                You can manage all your documents online and don't spend any more time on repetitive steps, just using solutions available. Most of them cover your needs for filling out and signing forms, but require you to use a desktop computer only. When a straightforward online PDF editor is not enough and more flexible solution is required, save your time and process your PDF documents faster than ever with pdfFiller.

                pdfFiller is a web-based document management service with an array of tools for modifying PDFs. This tool will be great for people who often in need to edit documents in PDF, fill out the form in Word, or convert a scanned image to editable format. Make your documents fillable, submit applications, complete forms, sign contracts, and so on.

                Got the pdfFiller website in order to begin working with your documents paper-free. Search your device storage for a required document to upload and edit, or simply create a new one yourself. From now on, you’ll be able to easily access any editing tool you need in one click.

                Use editing features to type in text, annotate and highlight. Change a document’s page order. Once a document is completed, download it to your device or save it to the third-party integration cloud. Collaborate with others to fill out the document. Add images into your PDF and edit its appearance. Add fillable fields and send for signing.

                Use one of the methods below to upload your document and start editing:
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                        Drag and drop a document from your device.
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                        Open the Enter URL tab and insert the link to your file.
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                        Get the form you need in our template library using the search.
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                        Upload a document from your cloud storage (Google Drive, Box, Dropbox, One Drive and others).
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                        Browse the Legal library.
                    

                            

                    

                Discover pdfFiller to make document processing simple, and ditch all the repetitive actions. Go paper-free with ease, submit forms and sign important contracts in one browser tab.
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        See for yourself by reading reviews on the most popular resources:
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                                    There was one issue- the orange pen would pop up when highlighting a word or sentence, suggesting an edit I assume. I would click it then stare at a blue circle waiting waiting waiting. I would just close the entire website and come back.
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I don't like the when people on my site go to my billable form that they can't list go right to the for. Like Hellosign.
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                    Get a powerful PDF editor for your Mac or Windows PC

                    Install the desktop app to quickly edit PDFs, create fillable forms, and securely store your documents in the cloud.

                    
                        Download pdfFiller for Mac OS

                        Download pdfFiller for Windows PC
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                    Edit and manage PDFs from anywhere using your iOS or Android device

                    Install our mobile app and edit PDFs using an award-winning toolkit wherever you go.

                    
                        Download from App Store

                        Download from Google Play
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                    Get a PDF editor in your Google Chrome browser

                    Install the pdfFiller extension for Google Chrome to fill out and edit PDFs straight from search results.

                    Download from Chrome Web Store

                

            

        

    


    
    
        
            
                
                    pdfFiller scores top ratings in multiple categories on G2
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                                    For pdfFiller’s FAQs
                            

            
                                    Below is a list of the most common customer questions. If you can’t find an answer to your question, please don’t hesitate to reach out to us.
                            

            
                                    
                        
                            
Can you rearrange pages in Word?
                        

                                                    Open Word and the document to reorder. Scroll to the page you want to move. Hold down the left mouse button and drag down to the right to select a whole page.

                                            

                                    
                        
                            
How do I rearrange pages in Word 2018?
                        

                                                    Open the Word document you want to rearrange pages in. Right-click and drag your mouse pointer over everything on the page(s) you want to move to highlight and select the contents. Press Ctrl + X to Cut the selection of text. The page(s) the text was on will be eliminated once it has been Cut.

                                            

                                    
                        
                            
How do I rearrange pages in Word for Mac?
                        

                                                    Click where you want your content to appear, then click in the toolbar. ... 
Select the text you want to move (objects set to move with text are also included), then choose Edit > Cut (from the Edit menu at the top of your screen).

                                            

                                    
                        
                            
How do I rearrange pages in Word 2007?
                        

                                                    Open Word and then your document. Go to the page to move and click at the very top of the page. Hold down the Shift” key and arrow down to the bottom of the page. You can also press the “PageD own” key, which selects one screen at a time.

                                            

                                    
                        
                            
Can you rearrange pages in Pages?
                        

                                                    Rearrange pages or sections Click View in the toolbar, choose Show Page Thumbnails, select the page or section thumbnail, then drag it to where you want it in the page hierarchy.

                                            

                                    
                        
                            
Can I rearrange pages in Word?
                        

                                                    Open Word and the document to reorder. Scroll to the page you want to move. Hold down the left mouse button and drag down to the right to select a whole page. Release the mouse and the page are highlighted.

                                            

                                    
                        
                            
How do I change the page order in Word 2013?
                        

                                                    Step 1: Open your document in Word 2013. Step 2: Click before the first character of the first word on the page that you want to move. Step 3: Use the scroll bar on the right side of the window to adjust the page view so that the bottom of the page is visible.

                                            

                                    
                        
                            
How do I make one-page landscape in Word 2016?
                        

                                                    Place your cursor at the very beginning of the page that you would like to flip to landscape. (... 
Select Layout or Page Layout > Breaks > Next Page to create a section.
Select the Page Layout tab and select Orientation > Landscape.

                                            

                            

        

                                                                                                                                        
    
    
    
    
        
            

            
                eSignature workflows made easy
            

            
                Sign, send for signature, and track documents in real-time with signNow.
            

            
                
                    Start free trial
                
            

        

    


            


            
                


    
        
            
                Resolva todos os seus problemas PDF

                
                                                                        
                                
                                    
Converter & Comprimir
                                

                                
                                    
                                                                                    
                                                Compactar PDF
                                            

                                                                                    
                                                Conversor de PDF
                                            

                                                                                    
                                                PDF OCR
                                            

                                                                                    
                                                Adicionar imagem para PDF
                                            

                                                                                    
                                                Editar PDF digitalizado
                                            

                                                                            

                                

                            

                                                    
                                
                                    
Dividir & Combinar
                                

                                
                                    
                                                                                    
                                                Dividir PDF
                                            

                                                                                    
                                                Combinar PDF
                                            

                                                                                    
                                                Combinar & Reordenar
                                            

                                                                                    
                                                Extrair páginas
                                            

                                                                            

                                

                            

                                                    
                                
                                    
Converter de PDF
                                

                                
                                    
                                                                                    
                                                Em PDF para o Word
                                            

                                                                                    
                                                PDF para Excel
                                            

                                                                                    
                                                PDF para PPT
                                            

                                                                                    
                                                PDF para JPG
                                            

                                                                            

                                

                            

                                                    
                                
                                    
Visualizar & Editar
                                

                                
                                    
                                                                                    
                                                Editar PDF
                                            

                                                                                    
                                                Excluir páginas
                                            

                                                                                    
                                                Rodar PDF
                                            

                                                                                    
                                                Leitor de PDF
                                            

                                                                                    
                                                Editar & Preencher
                                            

                                                                                    
                                                Numeração da página
                                            

                                                                                    
                                                Marca d'água
                                            

                                                                            

                                

                            

                                                    
                                
                                    
Converter para PDF
                                

                                
                                    
                                                                                    
                                                Palavra para PDF
                                            

                                                                                    
                                                PPT para PDF
                                            

                                                                            

                                

                            

                                                    
                                
                                    
Assinar & Segurança
                                

                                
                                    
                                                                                    
                                                eSign PDF
                                            

                                                                                    
                                                Proteger PDF
                                            

                                                                            

                                

                            

                                                            

                
                                                                                                                                
                                
                                    Converter & Comprimir
                                

                                                                                                        
                                    
                                        Compactar PDF
                                    

                                                                                                        
                                    
                                        Conversor de PDF
                                    

                                                                                                        
                                    
                                        PDF OCR
                                    

                                                                                                        
                                    
                                        Adicionar imagem para PDF
                                    

                                                                                                        
                                    
                                        Editar PDF digitalizado
                                    

                                                            

                                                                                                            
                                
                                    Dividir & Combinar
                                

                                                                                                        
                                    
                                        Dividir PDF
                                    

                                                                                                        
                                    
                                        Combinar PDF
                                    

                                                                                                        
                                    
                                        Combinar & Reordenar
                                    

                                                                                                        
                                    
                                        Extrair páginas
                                    

                                                            

                                                                                                            
                                
                                    Converter de PDF
                                

                                                                                                        
                                    
                                        Em PDF para o Word
                                    

                                                                                                        
                                    
                                        PDF para Excel
                                    

                                                                                                        
                                    
                                        PDF para PPT
                                    

                                                                                                        
                                    
                                        PDF para JPG
                                    

                                                            

                                                                                                            
                                
                                    Visualizar & Editar
                                

                                                                                                        
                                    
                                        Editar PDF
                                    

                                                                                                        
                                    
                                        Excluir páginas
                                    

                                                                                                        
                                    
                                        Rodar PDF
                                    

                                                                                                        
                                    
                                        Leitor de PDF
                                    

                                                                                                        
                                    
                                        Editar & Preencher
                                    

                                                                                                        
                                    
                                        Numeração da página
                                    

                                                                                                        
                                    
                                        Marca d'água
                                    

                                                            

                                                                                                            
                                
                                    Converter para PDF
                                

                                                                                                        
                                    
                                        Palavra para PDF
                                    

                                                                                                        
                                    
                                        PPT para PDF
                                    

                                                            

                                                                                                            
                                
                                    Assinar & Segurança
                                

                                                                                                        
                                    
                                        eSign PDF
                                    

                                                                                                        
                                    
                                        Proteger PDF
                                    

                                                            

                                                            

            

        

        
            
                
                    
                        
                            
                                

                                Sobre a gente
                            

                            
                                
                                    
                                        Preços
                                    

                                    
                                        Sobre a gente
                                    

                                    
                                        Líder
                                    

                                    
                                        Histórias de clientes
                                    

                                    
                                        Conformidade com GDPR
                                    

                                    
                                        Avaliações de usuários
                                    

                                    
                                        Torne-se um parceiro
                                    

                                    
                                        Programa para Afiliados
                                    

                                    
                                        Guia fiscal
                                    

                                    
                                        Notas de Versão
                                    

                                    
                                        Conformidade HIPAA
                                    

                                    
                                        Contatar vendas
                                    

                                    
                                        Reportar Política de Vulnerabilidade
                                    

                                

                            

                        

                        
                            
                                

                                Biblioteca de Formulários
                            

                            
                                
                                    
                                        Top 100 Formulários
                                    

                                    
                                        Mecanismo de Busca PDF
                                    

                                    
                                        Lista de Formulários A-Z
                                    

                                    
                                        Catálogo de Formulários
                                    

                                    
                                        Formulários Impostos do IRS
                                    

                                    
                                        Pesquisa popular
                                    

                                    
                                        W-2 Formulário
                                    

                                    
                                        W9
                                    

                                    
                                        Formulário 1099-MISC
                                    

                                    
                                        Formulário 1099-NEC
                                    

                                    
                                        DS11
                                    

                                    
                                        DS82
                                    

                                    
                                        1096
                                    

                                    
                                        Calendário de Impostos
                                    

                                    
                                        Modelos de documento
                                    

                                    
                                        Formulários adicionados recentemente
                                    

                                

                            

                        

                        
                            
                                

                                Funções
                            

                            
                                
                                    
                                        LinkToFill
                                    

                                    
                                        SendToSign
                                    

                                    
                                        Gerenciamento de documentos
                                    

                                

                            

                        

                        
                            
                                

                                Mudar para pdfFiller
                            

                            
                                
                                    
                                        Adobe Acrobat Alternativo
                                    

                                

                            

                        

                        
                            
                                

                                Integrações
                            

                            
                                
                                    
                                        Salesforce
                                    

                                    
                                        Dynamics
                                    

                                    
                                        Zapier
                                    

                                

                            

                        

                        
                            
                                

                                Assistência
                            

                            
                                
                                    
                                        Entre em contato
                                    

                                    
                                        Perguntas Frequentes
                                    

                                    
                                        Mapa do site
                                    

                                

                            

                        

                        
                            
                                

                                Para empresas
                            

                            
                                
                                    
                                        Organizações
                                    

                                    
                                        Empresa
                                    

                                    
                                        Seguro
                                    

                                    
                                        Medicamentos
                                    

                                    
                                        Setor imobiliário
                                    

                                    
                                        Recursos Humanos
                                    

                                    
                                        Imposto & Finanças
                                    

                                    
                                        Informações
                                    

                                

                            

                        

                        
                            
                                

                                API de ferramentas de PDF
                            

                            
                                
                                    
                                        API pdfFiller
                                    

                                    
                                        Documentação da API
                                    

                                    
                                        Preços API
                                    

                                

                            

                        

                        
                            
                                

                                Recursos
                            

                            
                                
                                    
                                        Assinatura Eletrónica
                                    

                                    
                                        Documentos jurídicos on-line
                                    

                                    
                                        Workflows AirSlate
                                    

                                    Não-codificar workflows

                                    
                                        Blogue
                                    

                                    
                                        Academia
                                    

                                    
                                        Webinars
                                    

                                    
                                        Tutoriais em Vídeo
                                    

                                

                            

                        

                    

                    
                        
                            
                                
                                    Sobre a gente
                                

                                
                                    Preços
                                

                                
                                    Líder
                                

                                
                                    Histórias de clientes
                                

                                
                                    Conformidade com GDPR
                                

                                
                                    Avaliações de usuários
                                

                                
                                    Torne-se um parceiro
                                

                                
                                    Programa para Afiliados
                                

                                
                                    Guia fiscal
                                

                                
                                    Notas de Versão
                                

                                
                                    Conformidade HIPAA
                                

                                
                                    Contatar vendas
                                

                                
                                    Reportar Política de Vulnerabilidade
                                

                            

                            
                                
                                    Para empresas
                                

                                
                                    Organizações
                                

                                
                                    Empresa
                                

                                
                                    Seguro
                                

                                
                                    Medicamentos
                                

                                
                                    Setor imobiliário
                                

                                
                                    Recursos Humanos
                                

                                
                                    Imposto & Finanças
                                

                                
                                    Informações
                                

                            

                        

                        
                            
                                
                                    Biblioteca de Formulários
                                

                                
                                    Top 100 Formulários
                                

                                
                                    Mecanismo de Busca PDF
                                

                                
                                    Lista de Formulários A-Z
                                

                                
                                    Catálogo de Formulários
                                

                                
                                    Formulários Impostos do IRS
                                

                                
                                    Pesquisa popular
                                

                                
                                    W-2 Formulário
                                

                                
                                    W9
                                

                                
                                    Formulário 1099-MISC
                                

                                
                                    Formulário 1099-NEC
                                

                                
                                    DS11
                                

                                
                                    DS82
                                

                                
                                    1096
                                

                                
                                    Calendário de Impostos
                                

                                
                                    Modelos de documento
                                

                                
                                    Formulários adicionados recentemente
                                

                            

                            
                                
                                    Recursos
                                

                                
                                    Assinatura Eletrónica
                                

                                
                                    Documentos jurídicos on-line
                                

                                
                                    Workflows AirSlate
                                

                                Não-codificar workflows

                                
                                    Blogue
                                

                                
                                    Academia
                                

                                
                                    Webinars
                                

                                
                                    Tutoriais em Vídeo
                                

                            

                        

                        
                            
                                
                                    Funções
                                

                                
                                    LinkToFill
                                

                                
                                    SendToSign
                                

                                
                                    Gerenciamento de documentos
                                

                            

                            
                                
                                    Mudar para pdfFiller
                                

                                
                                    Adobe Acrobat Alternativo
                                

                            

                            
                                
                                    Integrações
                                

                                
                                    Salesforce
                                

                                
                                    Dynamics
                                

                                
                                    Zapier
                                

                            

                            
                                
                                    Assistência
                                

                                
                                    Entre em contato
                                

                                
                                    Perguntas Frequentes
                                

                                
                                    Mapa do site
                                

                            

                            
                                
                                    API de ferramentas de PDF
                                

                                
                                    API pdfFiller
                                

                                
                                    Documentação da API
                                

                                
                                    Preços API
                                

                            

                        

                    

                    
                        
                            
                                
                                    Sobre a gente
                                

                                
                                    Preços
                                

                                
                                    Líder
                                

                                
                                    Histórias de clientes
                                

                                
                                    Conformidade com GDPR
                                

                                
                                    Avaliações de usuários
                                

                                
                                    Torne-se um parceiro
                                

                                
                                    Programa para Afiliados
                                

                                
                                    Guia fiscal
                                

                                
                                    Notas de Versão
                                

                                
                                    Conformidade HIPAA
                                

                                
                                    Contatar vendas
                                

                                
                                    Reportar Política de Vulnerabilidade
                                

                            

                        

                        
                            
                                
                                    Biblioteca de Formulários
                                

                                
                                    Top 100 Formulários
                                

                                
                                    Mecanismo de Busca PDF
                                

                                
                                    Lista de Formulários A-Z
                                

                                
                                    Catálogo de Formulários
                                

                                
                                    Formulários Impostos do IRS
                                

                                
                                    Pesquisa popular
                                

                                
                                    W-2 Formulário
                                

                                
                                    W9
                                

                                
                                    Formulário 1099-MISC
                                

                                
                                    Formulário 1099-NEC
                                

                                
                                    DS11
                                

                                
                                    DS82
                                

                                
                                    1096
                                

                                
                                    Calendário de Impostos
                                

                                
                                    Modelos de documento
                                

                                
                                    Formulários adicionados recentemente
                                

                            

                        

                        
                            
                                
                                    Funções
                                

                                
                                    LinkToFill
                                

                                
                                    SendToSign
                                

                                
                                    Gerenciamento de documentos
                                

                            

                            
                                
                                    Mudar para pdfFiller
                                

                                
                                    Adobe Acrobat Alternativo
                                

                            

                            
                                
                                    Integrações
                                

                                
                                    Salesforce
                                

                                
                                    Dynamics
                                

                                
                                    Zapier
                                

                            

                        

                        
                            
                                
                                    Assistência
                                

                                
                                    Entre em contato
                                

                                
                                    Perguntas Frequentes
                                

                                
                                    Mapa do site
                                

                            

                            
                                
                                    Para empresas
                                

                                
                                    Organizações
                                

                                
                                    Empresa
                                

                                
                                    Seguro
                                

                                
                                    Medicamentos
                                

                                
                                    Setor imobiliário
                                

                                
                                    Recursos Humanos
                                

                                
                                    Imposto & Finanças
                                

                                
                                    Informações
                                

                            

                        

                        
                            
                                
                                    API de ferramentas de PDF
                                

                                
                                    API pdfFiller
                                

                                
                                    Documentação da API
                                

                                
                                    Preços API
                                

                            

                            
                                
                                    Recursos
                                

                                
                                    Assinatura Eletrónica
                                

                                
                                    Documentos jurídicos on-line
                                

                                
                                    Workflows AirSlate
                                

                                Não-codificar workflows

                                
                                    Blogue
                                

                                
                                    Academia
                                

                                
                                    Webinars
                                

                                
                                    Tutoriais em Vídeo
                                

                            

                        

                    

                    
                        © 2024 airSlate Inc.
                            Todos os direitos reservados
                        

                        
                            
                                Aplicativo para computador

                            

                            
                                
                                    
                                        
                                            
                                            
                                            
                                            
                                            
                                            
                                            
                                            
                                            
                                            
                                            
                                            
                                            
                                            
                                            
                                            
                                            
                                            
                                            
                                            
                                            
                                            
                                            
                                            
                                            
                                            
                                            
                                            
                                        
                                        
                                            
                                                
                                            
                                        
                                    
                                
                            

                            
                                
                                    
                                        
                                        
                                        
                                        
                                        
                                        
                                    
                                
                            

                            
                                Aplicativo Móvel

                            

                            
                                
                                    
                                        
                                        
                                        
                                        
                                        
                                        
                                        
                                        
                                        
                                        
                                        
                                        
                                        
                                        
                                        
                                        
                                        
                                        
                                            
                                                
                                                
                                                
                                                
                                                
                                                
                                            
                                            
                                                
                                                
                                                
                                                
                                            
                                            
                                                
                                                
                                            
                                            
                                                
                                                
                                                
                                                
                                                
                                            
                                        
                                    
                                
                            

                            
                                
                                    
                                        
                                            
                                            
                                            
                                            
                                            
                                            
                                            
                                            
                                            
                                            
                                            
                                            
                                            
                                            
                                            
                                            
                                            
                                            
                                            
                                            
                                            
                                            
                                            
                                            
                                        
                                        
                                            
                                                
                                            
                                        
                                    
                                
                            

                        

                    

                    
                        
                            
                                
                                    
                                

                                
                                    
                                

                                
                                    
                                

                                
                                    
                                

                                
                                    
                                

                            

                        


                        
                        Seu uso deste site está sujeito a
                            Termos de Serviço
                        

                        
                            
                                
                                    Segurança
                                

                                
                                    Política de Privacidade
                                

                                
                                    DMCA
                                

                                
                                    Patentes
                                

                            

                        

                    

                

            

        

    



            
        


                        
        

        
            
                

                Nós usar cookies para melhorar a segurança, personalizar a experiência do utilizador melhorar nossas atividades de marketing (incluindo cooperar com nossos parceiros de marketing) e para outros usos empresariais. Click Aqui para ler nossa política de cookies. Em clicando em "Aceitar",  concorda com o uso de cookies. ... Leia maisLeia menos

            

            
                Aceitar
            

        

    




                
    
        
    


        
                
        
            
                
                    
                        
                            
                        
                    

                    
                        Please wait a moment
                    

                    
                        
                            
                                

                            

                            
                                Signing you up - 0%
                            

                        

                    

                

            

        

    

                    
    

        
        
            
        
    



        
            










        
    
            
    

        
                            
                    
                
                
                

                                        


            
                                                        
                

                
                                    
            
                            
            
                                                





                    

                    
                    
                    
                            
                            
    

            

                            
                
            
                            
                
            
                                                
                            
                        

            
                                                                            
    
    
    

                                



    
    
    
    
    
    

    
    
    

                    
    
                



                                    
    

                                        
                                        
                                        
                                        

                                      
